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安全和法规遵从信息
CY8CKIT-062-BLE PSoC 6 BLE Pioneer 套件仅用于开发目的。建议用户在 RF 开发环境中测试和评

估该套件。

此套件的安全评估是使用套件附带的默认附件在出厂默认设置下完成。所有安全评估均使用 5 V (USB
2.0， @ 500 mA) 电源进行。在本产品上安装额外的接线或从出厂默认设置修改产品可能会影响其性

能并对附近的其他设备造成干扰。如果检测到这种干扰，则应采取适当的缓解措施。

该套件不是成品，组装时不得转售或以其他方式销售，除非首先获得所有必需的授权。有关详细信息，
请联系 support@cypress.com。

通用安全说明

ESD 保护

可以损坏电路板和相关组件。赛普拉斯建议用户仅在 ESD 工作站环境中操作。如果这样的工作站不可

用，在器件进行操作时，请采取适当的 ESD 保护措施 : 戴上一个连接到板上的机架地 ( 任何未上漆的

金属平面 ) 的防静电手环。

处理电路板

CY8CKIT-062-BLE PSoC 6 BLE Pioneer 套件对 ESD 很敏感。只能握着电路板的边缘。从盒子里取

出电路板后，请将其放在一个接地的无静电平面上。如果可能，请使用一个导电泡沫垫。请勿将该电
路板在任何表面上滑动。

CY8CKIT-062-BLE 板包含 ESD 敏感器件。静电电荷很容易会在人体或

所有设备上累积，并且瞬间放电。高能量的静电释放会对设备造成永久
性伤害。建议采取适当的 ESD 预防措施，以避免降低其性能或丧失功

能。应将未使用的电路板储存在受保护的运输包装里。

过期时间 / 产品回收

从盒子背面显示的制造日期算起，该套件的有效期为五年。请联系离您
最近的回收商处理套件。
CY8CKIT-062-BLE PSoC 6 BLE Pioneer 套件指南, 文档编号: 002-29069 Rev. *A 5
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监管遵从信息

CY8CKIT-062-BLE PSoC 6 BLE Pioneer套件包含根据 2.4 GHz免许可频率范围的频谱规则发送和接

收无线电信号的设备。

赛普拉斯半导体公司已获得该套件的监管批准，可在特定国家使用。这些国家包括欧洲 (ETSI/CE) ，
美国 (FCC) ，加拿大 (ISEDC) 和日本 (TELC) 。可能需要额外的区域监管机构批准才能在全球范围内

运营这些产品。

出厂的 CY8CKIT-062-BLE PSoC 6 BLE Pioneer 套件已经过验证，符合以下要求 : 

作为符合 A 类标准的产品，满足 CE 要求

作为 B 类数字设备，符合 FCC 规则的第 15 部分

作为 B 类数字设备，符合加拿大 ICES-003

监管声明和产品标签

美国 (FCC)

CY8CKIT-062-BLE PSoC 6 BLE Pioneer 套件中的模块化发送器符合美国联邦通信委员会 (FCC) 规
则的第 15 部分。

该设备的 FCC ID 为 WAP-CY8CKIT-062。

操作需符合以下三个条件 : 
■ 该设备不可以产生有害干扰。

■ 此设备必须接受任何收到的干扰，包括可能导致意外操作的干扰。

■ 如果此模块内置于每个主机设备或每个主机机箱中，则需要 2 类许可更改 (C2PC) 。

射频暴露声明

本设备符合针对非受控制环境制定的 FCC 辐射暴露限制。安装和使用此设备，在设备与用户或第三方

之间距离至少为 20 厘米。

该模块标有自己的 FCC ID: WAP-CY8CKIT-062。如果在安装在其他设备中时看不到 FCC ID，则设备

必须在附加的参考模块上显示标签。在这种情况下，最终产品必须通过以下文本标记在可见的位置 : 

“FCC ID: WAP-CY8CKIT-062”

或

“ 包含 FCC ID: WAP-CY8CKIT-062”

注意 : 未经合规负责方明确批准的任何更改或修改可能会使用户无权操作

该设备。

只能使用经过模块认证的 PCB 天线。只有当它们具有相同类型且具有相

同或更低增益时，才可以使用其他天线
CY8CKIT-062-BLE PSoC 6 BLE Pioneer 套件指南, 文档编号: 002-29069 Rev. *A 6



Canada (ISEDC)

Le présent appareil est conforme aux CNR d' Innovation, Science and Economic Development
Canada applicables aux appareils radio exempts de licence. L'exploitation est autorisée aux deux
conditions suivantes: 

(1) l'appareil ne doit pas produire de brouillage, et 

(2) l'utilisateur de l'appareil doit accepter tout brouillage radioélectrique subi, même si le brouillage
est susceptible d'en compromettre le fonctionnement.: 

Cet équipement est conforme aux limites d'exposition aux radiofréquences définies par Innovation,
Science and Economic Development Canada pour un environnement non contrôlé. Cet équipement
doit être installé et utilisé avec un minimum de 20cm de distance entre le dispositif et l'utilisateur ou
des tiers.

Ce module est étiqueté avec son propre IC: 7922A-CY8CKIT062. Si le numéro de certification IC,
n'est pas visible lorsqu'il est installé à l'intérieur d'un autre appareil, l'appareil doit afficher l'étiquette
sur le module de référence ci-joint. Dans ce cas, le produit final doit être étiqueté dans un endroit
visible par le texte suivant: 

“IC: 7922A-CY8CKIT062”

 OR 

“Contains IC: 7922A-CY8CKIT062”

Japan (TELEC)

005-101696

CY8CKIT-062-BLE
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1. 简介
感谢您 CY8CKIT-062-BLE PSoC 6 BLE Pioneer 套件的关注。PSoC 6 BLE Pioneer 套件让您能够使

用配置 BLE 连接的 PSoC 6 MCU ( 后文简称 PSoC 6 MCU) 评估和开发应用程序。

PSoC 6 MCU 是赛普拉斯最新的超低功耗 PSoC，专为可穿戴设备和物联网产品 (IoT) 而设计。它是
一个可编程嵌入式片上系统，集成了150-MHz Arm® Cortex®-M4作为主要应用处理器，集成100 MHz
CM0+，支持低功耗操作，高达 1 MB 闪存和 288 KB SRAM， CapSense® 触摸感应和可编程模拟和
数字外设，可实现更高的灵活性，现场调整设计，加快产品上市速度。

PSoC 6 BLE Pioneer 板提供与 Arduino™ 屏蔽板的兼容性。该板具有 PSoC 6 MCU，512 Mb NOR 闪

存，板载编程器 / 调试器 (KitProg2) ，2.4-GHz WLAN 和蓝牙功能模块 (CYW4343W) ，USB Type-C
供电系统 (EZ-PD™ CCG3) ，一个五段 CapSense 滑块，两个 CapSense 按键，一个 CapSense 接

近感应接头，一个 RGB LED，两个用户 LED，以及一个按钮。该电路板支持 PSoC 6 MCU 的 1.8 V
至 3.3 V 的工作电压。

CY8CKIT-062-BLE 封装包括一个 CY8CKIT-028-EPD E-INK 显示屏，包含一个 2.7 英寸的 E-INK 显

示屏，一个运动传感器，一个热敏电阻和一个 PDM 麦克风。套件包还包含一个 CY5677 CySmart BLE
4.2 USB Dongle，这个在出厂时已经编程以模拟 BLE GAP 中央设备，使您可以模拟计算机上的 BLE
主机。

您可以使用 PSoC Creator™ 开发和调试 PSoC 6 MCU 项目。PSoC Creator 是赛普拉斯的标准集成设

计环境 (IDE) 。 PSoC Creator 还支持将您的设计导出到其他第三方固件开发工具。

如果您不熟悉 PSoC 6 MCU 和 PSoC Creator IDE，可以在应用笔记 AN210781 - Getting Started with
PSoC 6 MCU with Bluetooth Low Energy (BLE) Connectivity 中找到介绍。

1.1 套件内容

CY8CKIT-062-BLE 封装包含以下内容，如 Figure 1-1 所示。

■ PSoC 6 BLE Pioneer 板
■ CY8CKIT-028-EPD E-INK 显示屏

■ CY5677 CySmart BLE 4.2 USB Dongle
■ USB Type-A 转 Type-C 线缆

■ 4 根跳线 ( 每根 4 英寸长 )
■ 两根接近传感器线缆 ( 每根 5 英寸长 )
■ 快速入门指南
CY8CKIT-062-BLE PSoC 6 BLE Pioneer 套件指南, 文档编号: 002-29069 Rev. *A 8
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简介
Figure 1-1.  套件内容

检查套件的内容 ; 如果发现任何部件丢失，请联系离您最近的赛普拉斯销售办事处寻求帮助 :
www.cypress.com/support.

1.2 电路板的详细信息

Figure 1-2 显示了具有以下功能的 Pioneer 板 : 
■ PSoC 6 MCU 配备 BLE 连接功能

■ 与 Arduino Uno™3.3 V 屏蔽板1 和 Digilent®Pmod™ 模块兼容的扩展接头

■ 512-Mbit 外部四 SPI NOR 闪存，为数据和代码提供快速，可扩展的存储器

■ KitProg2板载编程器 /调试器，具有大容量存储编程，USB转UART/I2C/SPI桥接功能以及定制应用

支持

■ EZ-PD CCG3 USB Type-C 充电 (PD) 系统，带可充电锂离子聚合物 (Li-Po) 电池支持2

■ CapSense 触摸感应滑块 (5 个元件 ) ，两个按钮，所有这些按钮都具有自电容 (CSD) 和互电容 
(CSX) 操作，以及 CSD 接近传感器，可让您评估赛普拉斯的第四代 CapSense 技术

■ 支持 1.8 V 至 3.3 V 的 PSoC 6 MCU 操作。为备用域供电提供额外的 330 mF 超级电容 (Vbackup) 
■ 两个用户 LED，一个 RGB LED，一个用户按钮和一个用于 PSoC 6 MCU 的复位按钮。用于

KitProg2 的两个按钮和三个 LED

1. 不支持 5V 屏蔽板
2. 具有电池和供电功能的 USB Type-C 至 Type-C 电缆不包含在套件包中，应单独购买。
CY8CKIT-062-BLE PSoC 6 BLE Pioneer 套件指南, 文档编号: 002-29069 Rev. *A 9
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简介
Figure 1-2.  Pioneer 板
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简介
Table 1-1.  Pioneer 板上的选择开关

开关 板上的位置 用途 默认位置

SW5 前
选择 PSoC 6 MCU 的 VDD 电源介于 1.8 V， 3.3 V 和 1.8 V 至 3.3 V
之间，由 KitProg2 控制。

3.3V

SW6 后

在 PSoC 6 MCU 位置 : 

■ KitProg2 可以对板载 PSoC 6 MCU 进行编程

■ 此外，PSoC 6 MCU 可由外部编程器 ( 如连接

到 J11 的 MiniProg3) 编程

避免将任何外部设备连接到 “PSoC 6 MCU” 位置的 J11，因为它可能

导致编程失败。

在外部设备位置 : 

■ KitProg2可以对连接到 J11的任何 PSoC 4/5/6
器件进行编程

PSoC 6 MCU

SW7 后

在 VDDD 和超级电容之间选择 PSoC 6 MCU 的 Vbackup 电源连接。

选择 VDDD 时，可通过 KitProg2 打开 / 关闭稳压器。选择超级电容

时， PSoC 6 MCU 可以打开 / 关闭稳压器。

VDDD/KitProg2
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简介
Figure 1-3 显示了 Pioneer 板的引脚排列。

Figure 1-3.  Pioneer 板引脚排列

Table 1-2.  Pioneer 板引脚排列

PSoC 6 
引脚

主要板上功能
次要

板上功能
连接详情

ANT RFIO, 天线 –

XI ECO IN –

XO ECO OUT –

XRES 复位 –

P0.0 WCO IN –

P0.1 WCO OUT –
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P0.2 Arduino 接头 J4.8, D7 –

P0.3 RGB 红色 LED –

P0.4 具有休眠唤醒功能的用户
按钮

PMIC 唤醒信号

默认情况下，作为低电平有效逻辑连接到地。移除
R150 并填充 R149 和 R148 以将开关更改为高电平

有效逻辑。有关返工， Rev. 08 或更早版本的更多信

息，请参阅常见问题 on page 57 ( 第 29 项 ) 。

P0.5 PMIC 控制 –

P1.0 CapSense Tx 非 Arduino 接头

(J19.5) 上 GPIO
默认情况下连接到 CapSense。移除 R43 以断开

CapSense 连接或添加 R101 以连接到接头。

P1.1 RGB 绿色 LED –

P1.2 非 Arduino 接头 (J19.4)
上 GPIO

–

P1.3 非 Arduino 接头 (J19.3)
上 GPIO

–

P1.4 非 Arduino 接头 (J19.2)
上 GPIO

–

P1.5 橙色用户 LED 非 Arduino 接头 
(J19.1) 上 GPIO

默认情况下连接到主要和辅助功能。移除 R13 以断开

与 LED 的连接。

P5.0
Arduino J4.1, D0

UART RX
KitProg2 UART TX

–
移除 R120 以断开与 KitProg2 UART TX 的连接

P5.1
Arduino J4.2, D1

UART TX
KitProg2 UART RX

– 移除 R119 以断开与 KitProg2 UART RX 的连接

P5.2
Arduino J4.3, D2

UART RTS
KitProg2 UART CTS

–
移除 R77 并加载 R78 以断开与 KitProg2 UART CTS
的连接 ( 这也将断开与 KitProg2 的 RTS 和 SPI 线路

连接 ) 

P5.3
Arduino J4.4, D3

UART CTS
KitProg2 UART RTS

–
移除 R77 并加载 R78 以断开与 KitProg2 UART CTS
的连接 ( 这也将断开与 KitProg2 的 RTS 和 SPI 线路

连接

P5.4 Arduino J4.5, D4 –

P5.5 Arduino J4.6, D5 –

P5.6 Arduino J4.7, D6 –

P6.0
Arduino J3.10, SCL
KitProg2 I2C SCL

– 移除 R109 以断开与 KitProg2 I2C SCL 的连接

P6.1
Arduino J3.9, SDA
KitProg2 I2C SDA

– 移除 R114 以断开与 KitProg2 I2C SDA 的连接

P6.2 非 Arduino 接头 (J2.15)
上 GPIO

–

Table 1-2.  Pioneer 板引脚排列 (continued)

PSoC 6 
引脚

主要板上功能
次要

板上功能
连接详情
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P6.3 非 Arduino 接头 (J2.17)
上 GPIO CapSense 屏蔽

移除 R144 以断开与 GND 的连接并填充 R138 以连

接到 CapSense 屏蔽 ( 板上散列模式 ) 

P6.4 TDO/SWO –

P6.5 TDI –

P6.6 TMS/SWDIO – 移除 R147 以断开与 KitProg2 SWDIO 的连接

P6.7 TCLK/SWCLK – 移除 R146 以断开与 KitProg2 SWCLK 的连接

P7.0 TRACECLK 非 Arduino 接头 
(J18.6) 上 GPIO 填充 R135 以连接到 J18 接头

P7.1 CINTA –

P7.2 CINTB CSH 移除 C87 (0.47 nF) 并填充 10 nF 用于 CSH

P7.3 非 Arduino 接头 (J18.5)
上 GPIO

CSH 移除 R88 以断开与接头的连接，并为 CSH 填充 C88 
(10 nF) 

P7.4 TRACEDATA[3] 非 Arduino 接头 
(J18.4) 上 GPIO 填充 R132 以连接到 J18

P7.5 TRACEDATA[2] 非 Arduino 接头

(J18.3) 上 GPIO 填充 R133 以连接到 J18

P7.6 TRACEDATA[1] 非 Arduino 接头

(J18.2) 上 GPIO 填充 R134 以连接到 J18

P7.7 CMOD 非 Arduino 接头 
(J18.1) 上 GPIO 填充 R87 以连接到 J18

P8.0 Proximity 非 Arduino 接头 
(J20.1) 上 GPIO 将 R31 替换为零欧姆并填充 R34 以连接到接头

P8.1 CapSense Button0 Rx 非 Arduino 接头 
(J20.2) 上 GPIO

移除 R44 以断开 CapSense 板并填充 R100 以连接

到接头

P8.2 CapSense Button1 Rx 非 Arduino 接头

(J20.3) 上 GPIO
移除 R50 以断开 CapSense 板并填充 R103 以连接

到接头

P8.3 CapSense Silder0 Rx 非 Arduino 接头 
(J20.4) 上 GPIO

移除 R45 以断开 CapSense 板并填充 R99 以连接到

接头

P8.4 CapSense Silder1 Rx 非 Arduino 接头

(J20.5) 上 GPIO
移除 R46 以断开 CapSense 板并填充 R97 以连接到

接头

P8.5 CapSense Silder2 Rx 非 Arduino 接头 
(J20.6) 上 GPIO

移除 R47 以断开 CapSense 板并填充 R105 以连接

到接头

P8.6 CapSense Silder3 Rx 非 Arduino 接头

(J20.7) 上 GPIO
移除 R48 以断开 CapSense 板并填充 R98 以连接到

接头

P8.7 CapSense Silder4 Rx 非 Arduino 接头

(J20.8) 上 GPIO
移除 R49 以断开 CapSense 板并填充 R104 以连接

到接头

P9.0 非 Arduino 接头 (J2.2) 上
GPIO –

P9.1 非 Arduino 接头 (J2.4) 上
GPIO –

Table 1-2.  Pioneer 板引脚排列 (continued)

PSoC 6 
引脚

主要板上功能
次要

板上功能
连接详情
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P9.2 非 Arduino 接头 (J2.6) 上
GPIO –

P9.3 TRACEDATA[0] 非 Arduino 接头

(J2.8) 上 GPIO 填充 R131 以连接到接头

P9.4 非 Arduino 接头 (J2.10)
上 GPIO

–

P9.5 非 Arduino 接头 (J2.12)
上 GPIO

–

P9.6 非 Arduino 接头 (J2.16)
上 GPIO

–

P9.7 非 Arduino 接头 (J2.18)
上 GPIO

–

P10.0 Arduino J2.1, A0 –

P10.1 Arduino J2.3, A1 –

P10.2 Arduino J2.5, A2 –

P10.3 Arduino J2.7, A3 –

P10.4
Arduino J2.9, A4

PDM_CLK
–

P10.5
Arduino J2.11, A5

PDM_DAT
–

P10.6 非 Arduino 接头 (J2.13)
上 GPIO

–

P11.0 FRAM CS 非 Arduino 接头

(J18.8) 上 GPIO
默认情况下连接到主要和辅助功能。移除 R17 以断开

与 J18 的连接，并在 FRAM 上拉时加载 R10 (10K) 。

P11.1 RGB 蓝色 LED –

P11.2 QSPI FLASH CS 非 Arduino 接头 
(J18.7) 上 GPIO

填充 R8 以连接到 J18，移除 R5 和 R7 以断开与闪存

和上拉的连接。

P11.3 QSPI FLASH/
FRAM DATA3 –

P11.4 QSPI FLASH/
FRAM DATA2 –

P11.5 QSPI FLASH/
FRAM DATA1 –

P11.6 QSPI FLASH/
FRAM DATA0 –

P11.7 QSPI FLASH/
FRAM CLK –

P12.0
Arduino J3.4, D11

SPI MOSI
–

移除 R77 并加载 R78 以断开与 KitProg2_SPI 线路的

连接 ( 这也将断开与 KitProg2 的 RTS 和 CTS 线路连

接 ) 

Table 1-2.  Pioneer 板引脚排列 (continued)

PSoC 6 
引脚

主要板上功能
次要

板上功能
连接详情
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P12.1
Arduino J3.5, D12

SPI MISO
– 移除 R77 并加载 R78 以断开与 KitProg2_SPI 线的连

接 ( 这也将断开与 KitProg3 的 RTS 和 CTS 线路 ) 

P12.2
Arduino J3.6, D13

SPI CLK
–

移除 R77 并加载 R78 以断开与 KitProg2_SPI 线路的

连接 ( 这也将断开与 KitProg4 的 RTS 和 CTS 线路连

接 ) 

P12.3
Arduino J3.3, D10

SPI SELECT
–

移除 R77 并加载 R78 以断开与 KitProg2_SPI 线路的

连接 ( 这也将断开与 KitProg5 的 RTS 和 CTS 线路连

接 ) 

P12.4 KitProg2 SPI SELECT 非 Arduino 接头 
(J19.10) 上 GPIO

默认情况下连接到主要和辅助功能。移除 R81 以断开

与 J19 的连接或移除 R84 以断开
KitProg2_SPI_SELECT

P12.5 PMOD SPI SELECT 非 Arduino 接头 
(J19.9) 上 GPIO

默认情况下连接到主要和辅助功能。移除 R71 以断开

与 J19 的连接或移除 R82 以断开
PMOD_SPI_SELECT

P12.6 非 Arduino 接头 (J19.7)
上 GPIO

–

P12.7 非 Arduino 接头 (J19.5)
上 GPIO

–

P13.0 Arduino J3.1, D8 –

P13.1 Arduino J3.2, D9 –

P13.6 非 Arduino 接头 (J2.19)
上 GPIO

CapSense Shield 移除 R144 以断开与 GND 的连接并填充 R137 以连

接到 CapSense 扩展板 ( 板上散列模式 ) 

P13.7 红色用户 LED 非 Arduino 接头 
(J2.20) 上 GPIO

默认情况下连接到主要和辅助功能。移除 R16 以断开

与 LED 的连接。

VREF SAR BYPASS, J3.8, 
AREF –

Table 1-2.  Pioneer 板引脚排列 (continued)

PSoC 6 
引脚

主要板上功能
次要

板上功能
连接详情
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Figure 1-4 显示了具有以下功能的 E-INK 显示扩展板 : 
■ 2.7 英寸单色 E-INK 显示屏，分辨率为 264 x 176。即使在没有电源的情况下，E-INK 显示器也可以

保留其内容，从而提供超低功耗， “ 始终开启 ” 的显示功能

■ 热敏电阻，可对显示屏进行温度补偿以及通用温度测量。

■ 3 轴加速和 3 轴陀螺仪运动传感器

■ 用于语音输入的 PDM 麦克风

■ I/O电平转换器，通过为E-INK显示器提供恒定的 3.3 V接口，允许电路板在 1.8 V至 1.8 V-5 V的任

何电压下工作

■ 一个负载开关，可由电路板控制，以切换 E-INK 显示器的电源。

Figure 1-4.  E-INK 显示扩展板
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Figure 1-5 显示了 E-INK 显示扩展板的引脚分布。

Figure 1-5.  E-INK 扩展板引脚分布
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Table 1-3.  E-INK 扩展板引脚分布

Pin # Arduino 引脚 Arduino 功能 E-INK 扩展板功能 Pioneer 板连接

J3.1 D8 DIGITAL I/O IMU INT1 P13[0]

J3.2 D9 PWM IMU INT2 P13[1]

J3.3 D10 SS/PWM SSEL P12[3]

J3.4 D11 MOSI/PWM MOSI P12[0]

J3.5 D12 MISO MISO P12[1]

J3.6 D13 SCK SCLK P12[2]

J3.7 D14 GND GND GND

J3.8 D15 analog ref i/p NC VREF

J3.9 SCL SDA IMU I2C SDA P6[1]

J3.10 SDA SCL IMU I2C SCL P6[0]

J4.1 D0 RX NC NC

J4.2 D1 TX NC NC

J4.3 D2 DIGITAL I/O EPD reset P5[2]

J4.4 D3 PWM, I/O BUSY P5[3]

J4.5 D4 DIGITAL I/O EPD enable P5[4]

J4.6 D5 PWM, I/O DISCHARGE P5[5]

J4.7 D6 PWM, I/O BORDER P5[6]

J4.8 D7 DIGITAL I/O EPD I/O enable P0[2]

J2.1 A0 ADC0 THERM VDD P10[0]

J2.2 A1 ADC1 THERM OUT P10[1]

J2.3 A2 ADC2 THERM OUT P10[2]

J2.4 A3 ADC3 THERM GND P10[3]

J2.5 A4 ADC4 PDM CLK P10[4]

J2.6 A5 ADC5 PDM DATA P10[5]
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1.3 PSoC Creator
PSoC Creator 是一个先进、简单易用的集成开发环境 (IDE) 。它引进了革命性的硬件和软件协同设计

理念，它有一个预验证和预配置的 PSoC Components™ 库以及外设驱动库 (PDL)，如 Figure 1-6 所

示。通过 PSoC Creator，您可以 : 
1. 拖放组件以在主设计工作区中构建硬件系统设计。

2. 使用 PSoC 硬件共同设计应用程序固件。

3. 使用配置工具或 PDL 配置组件。

4. 探索 100 多个组件库。

5. 访问组件数据表。

6. 将您的设计导出到第三方固件开发工具。

Figure 1-6.  PSoC Creator 特性

PSoC Creator 还使您能够利用集成的编译器链和 PSoC 器件的生产编程器进入整个工具生态系统。
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1.3.1 PSoC Creator 代码示例

PSoC Creator 包含大量代码示例。可以从 PSoC Creator Start Page 访问这些示例，如 Figure 1-7 所

示，也可以从 File> Code Example 菜单中访问。

代码示例可以通过完整的设计加速您的设计流程。代码示例还说明了如何将 PSoC Creator 组件用于

各种应用程序。包含代码示例和文档。

在 “Find Code Example” 对话框中，您有以下几种选择 : 
■ 根据设备系列或关键字筛选示例。

■ 从基于 “Filter Options” 提供的示例列表中进行选择。

■ 查看选择的项目文档 ( 在 “Documentation” 选项卡上 ) 。
■ 在 “Sample Code” 选项卡上查看选择的代码。您还可以将此窗口中的代码复制并粘贴到项目中，

这有助于加快代码开发速度。

■ 为代码示例创建新工作区或添加到现有工作区。这可以通过完整的基本设计启动您的设计从而加
快您的设计过程。然后，您可以调整该设计以适应您的应用。

Figure 1-7.  PSoC Creator 中的代码示例

1.3.2 套件代码示例

您可以从 PSoC Creator 起始页访问已安装的套件代码示例。要访问这些示例，请展开 “ 示例和套件 ”
部分下的套件 ; 然后，展开特定套件以查看代码示例。有关可在此工具包上使用的代码示例列表，请

参阅代码示例 chapter on page 40。

1.3.3 PSoC Creator 帮助

启动 PSoC Creator 并导航到以下项目 : 
■ Quick Start Guide: 选择 Help > Documentation > Quick Start Guide。本指南为您提供了开发

PSoC Creator 项目的基础知识。

■ Simple Component Code Examples: 选择 File > Code Example。这些示例演示了如何配置和

使用 PSoC Creator 组件。要访问与特定组件相关的示例，请右键单击原理图或组件目录中的组

件。在出现的上下文菜单中选择 “Find Code Example” 选项。

■ System Reference Guide: 选择 Help > System Reference Guide。本指南列出并描述了 PSoC 
Creator 提供的系统功能。

■ Component Datasheets: 右键单击组件，然后选择Open Datasheet。访问PSoC 6组件数据表页

面，获取所有 PSoC 6 组件数据表的列表。
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1.4 入门

本指南将帮助您熟悉 PSoC 6 BLE Pioneer 套件 : 
■ 软件安装 chapter on page 25 介绍了套件软件的安装。这包括用于开发和调试应用程序的 PSoC 

Creator IDE 和 PDL，用于将 .hex 文件编程到设备上的 PSoC Programmer，以及用于模拟 GAP
核心角色的主机设备的 CySmart。

■ 套件操作 chapter on page 28 介绍了 PSoC 6 BLE Pioneer 套件的主要功能以及编程，调试以及

USB-UART 和 USB-I2C 桥接等功能。

■ 代码示例 chapter on page 40 介绍了多个 PSoC 6 MCU 代码示例，可帮助您了解如何创建自己的

PSoC 6 项目。

■ 附录 on page 43 提供了详细的硬件描述，使用板载 NOR 闪存和板载 EZ-PD™CCG3 Type-C 供电

系统的方法，套件原理图和物料清单 (BOM) 。

1.5 额外学习资源

赛普拉斯在 www.cypress.com/psoc6 上提供了大量数据，可帮助您为您的设计选择合适的 PSoC 器

件，并帮助您快速有效地将器件集成到您的设计中。

1.6 技术支持

若您需要技术支持，请访问赛普拉斯支持或者致电我们公司的客户支持 +1 (800) 541-4736 选择 3 ( 美
国 ) 或 +1 (408) 943-2600 选择 3 ( 国际 ) 。

若想获得快速支持，您同样也可以使用下面的支持资源 : 
■ 自助服务 ( 技术文档 )
■ 所在地销售办事处

1.7 文档规范

Table 1-4.  指南的文档规范

Convention Usage

Courier New
显示文件位置，用户输入的文本和源代码 :
C:\...cd\icc\

Italics 显示文件名和参考文档 :
阅读 PSoC Creator User Guide 中的 sourcefile.hex 文件

[ 方括号、粗体 ] 在操作步骤中显示键盘命令 : 
[Enter] or [Ctrl] [C]

File > Open 表示菜单路径 :
File > Open > New Project

粗体字
在操作步骤中显示命令，菜单路径和图标名称 : 
点击 File 图标然后点击 Open。

Times New Roman 字体
显示等式 :
2 + 2 = 4

灰色框中的文本 描述产品的注意事项或独特功能。
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1.8 缩略语
Table 1-5.  本文档中使用的缩略语

缩略语 含义

ADC 模数转换器

BLE 低功耗蓝牙

BOM 物料清单

CINT 集成电容

CMOD 调制器电容

CPU 中央处理单元

CSD CapSense sigma delta

CTANK 屏蔽槽电容

DC 直流电

Del-Sig delta-sigma

ECO 外部晶振

EPD 电子纸显示屏

ESD 静电释放

F-RAM 铁电随机存取存储器

FPC 柔性印刷电路

GPIO 通用输入 / 输出

HID 人机界面设备

I2C 内部集成电路

IC 集成电路

ICSP 在线串行编程

IDAC 电流数模转换器

IDE 集成开发环境

LED 发光二极管

PC 个人电脑

PD 充电

PDM 脉冲密度调制

PTC 正温度系数

PSoC 可编程片上系统

PWM 脉冲宽度调制

RGB 红绿蓝

SAR 逐次逼近寄存器

SPI 串行外设接口

SRAM 串行随机存取存储器
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简介
SWD 串行线调试

UART 通用异步接收发射机

USB 通用串行总线

WCO 时钟晶振

Table 1-5.  本文档中使用的缩略语 (continued)

缩略语 含义
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2. 软件安装
本章介绍在 PC 上安装软件工具和软件包以使用 PSoC 6 BLE Pioneer 套件的步骤。这包括用于构建

项目并编程的 IDE。

2.1 安装准备

要安装赛普拉斯软件，您需要管理员权限。但是，要运行已安装的软件并不需要此权限。在安装套件
软件之前，请关闭当前正在运行的任何其他赛普拉斯软件。

2.2 安装软件

按照以下步骤安装 PSoC 6 BLE Pioneer Kit 软件 : 
1. 从 www.cypress.com/CY8CKIT-062-BLE 下载并运行 CY8CKIT-062-BLE PSoC 6 BLE Pioneer 套

件软件。该套件软件有两种不同的格式可供下载。

a. CY8CKIT-062-BLE 套件完整安装 : 此安装包包含与套件相关的文件，包括 PSoC Creator，
PSoC Programmer， PDL 和 CySmart。但是，它不包括 Windows Installer 或 Microsoft .NET
框架包。如果您的计算机上没有这些软件包，安装程序将指示您从 Internet 下载并安装它们。

b. 只安装 CY8CKIT-062-BLE 套件 : 此可执行文件仅安装套件内容，其中包括套件代码示例，硬

件文件和用户文档。如果您的 PC 上安装了所有必备软件 ( 在步骤 5 中列出 ) ，则可以使用此

软件包。
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软件安装
2. 选择要安装 PSoC 6 BLE Pioneer Kit 相关文件的文件夹。选择目录并单击 Next。

Figure 2-1.  套件安装截图

3. 单击 Next 时，安装程序会自动安装所需的软件 ( 如果您的计算机上没有该软件 ) 。以下是必需的

软件 : 
a. PSoC Creator 4.2: 该软件可单独下载，下载路径 : 

www.cypress.com/psoccreator. PSoC Creator 4.2 安装程序会自动安装以下附加软件 : 
PSoC Programmer 3.27.0 
Peripheral Driver Library 3.0.1 

b. CySmart 1.2 SP1 或更高版本，可从 www.cypress.com/cysmart 单独下载。

4. 选择 Typical, Custom, 或 Complete 安装类型 ( 如果您不知道选择哪一个，请选择 Typical) ，如

Figure 2-2 所示。选择安装类型后单击 Next。
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软件安装
Figure 2-2.  产品安装概览

5. 阅读许可协议，然后选择 I accept the terms in the license agreement 以继续安装。点击

Next。
6. 安装开始时，安装页面上会显示一个安装包列表。成功安装后，每个安装包旁边都会出现绿色复

选标记。

7. 输入您的联系信息或选中 Continue Without Contact Information 复选框。单击 Finish 以完成

CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit 软件安装。

8. 安装完成后，套件内容可在以下位置获得 : 
<Install_Directory>\CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit

Default location: 默认位置 : 
Windows 7 (64-bit): C:\Program Files (x86)\Cypress\CY8CKIT-062-BLE PSoC 6 
BLE Pioneer Kit

Windows 7 (32-bit): C:\Program Files\Cypress\CY8CKIT-062-BLE PSoC 6 BLE 
Pioneer Kit

注意 : 对于 Windows 7/8/8.1/10 用户，安装的文件和文件夹是只读的。要使用已安装的代码示例，请

按照代码示例 chapter on page 40 一章中列出的步骤操作。这些步骤将在您选择的路径中创建示例的

可编辑副本，因此不会修改原始安装的示例。
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3. 套件操作
本章介绍PSoC 6 BLE Pioneer套件的各种功能，包括操作原理，板上编程和调试功能，KitProg2 USB-
UART， USB-I2C， USB-SPI 桥接器和 USB Type-C 供电。

3.1 操作原理

PSoC 6 BLE Pioneer 套件围绕 PSoC 6 MCU 构建。 Figure 3-1 显示了 PSoC 6 BLE Pioneer 套件中

使用的 PSoC 6 MCU 器件的框图。有关器件功能的详细信息，请参见器件数据手册。

Figure 3-1.  PSoC 6 MCU 框图
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套件操作
Figure 3-2 显示了 Pioneer 板框图。

Figure 3-2.  Pioneer 板框图
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套件操作
CY8CKIT-062-BLE Pioneer 套件随 PSoC 6 BLE Pioneer 板一起提供，与 CY8CKIT-028-EPD E-INK
显示扩展板连接，如 Figure 3-3 所示。

Figure 3-3.  PSoC 6 BLE Pioneer 板和 E-INK 显示扩展板

Figure 3-4 显示了 Pioneer 板的标记。

Figure 3-4.  PSoC 6 BLE Pioneer 板 - 顶视图
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套件操作
PSoC 6 BLE Pioneer 板具有以下外设 : 
1. 电池充电指示灯 (LED7): 当板上电池充电器为连接到 J15 的锂铁聚合物电池充电时，此 LED 亮

起。请注意，电池连接器和电池不包含在套件中，如果您需要测试电池充电功能，则应单独购
买。

2. USB PD 输出指示灯 (LED6): 当 USB Type-C 供电输出可用时，此 LED 指示灯亮起。

3. KitProg2 USB 连接器 (J10): 与 PSoC 6 BLE Pioneer 套件一起提供的 USB 电缆连接此 USB 连

接器和 PC，以使用 KitProg2 板载编程器和调试器，并为 Pioneer 板提供电源。 J10 还用于 USB 
Type-C 供电系统。有关详细信息，请参阅 EZPD CCG3 Type-C 供电 on page 38。

4. 带 PD 功能的赛普拉斯 EZ-PD™CCG3 Type-C 端口控制器 (CYPD3125-40LQXIT， U3): Pioneer
板包括带有供电系统的赛普拉斯 EZ-PD™CCG3 USB Type-C 端口控制器。该 EZ-PD™CCG3 器

件经过预编程，可以从 Type-C 端口向板载接头 J16 供电，同时为连接到 J15 的锂离子聚合物电

池充电。此外，供电系统可以利用从 VIN 电源获得的电力向 Type-C 功率接收器或诸如蜂窝电话

的消费电子供电。有关详细信息，请参阅 EZPD CCG3 Type-C 供电 on page 38。
5. KitProg2 编程模式选择按钮 (SW3): 该按钮可用于在 KitProg2 的各种操作模式之间切换 ( 专有

SWD 编程或大容量存储编程 /CMSIS-DAP 模式 ) 。此按钮还可用于在自定义应用模式下为 PSoC 
5LP 提供输入。有关更多详细信息，请参阅 “KitProg2 用户指南 ”。

6. KitProg2 I/O 接头 (J6): 该接头引出了板载 KitProg2 PSoC 5LP 器件的几个 GPIO。这包括 USB-
I2C， USB-UART 和 USB-SPI 桥接线。附加的 PSoC 5LP 引脚直接连接到 PSoC 5LP 的内部可

编程模拟逻辑。您也可以将这些引脚用于自定义应用程序。有关 KitProg2 的更多详细信息，请参

阅 KitProg2 用户指南。

7. KitProg2 编程 / 自定义应用程序头 (J7): 此接头引出了更多 PSoC 5LP 的 GPIO，可用于自定义

应用程序。它还包含用于 PSoC 5LP 的 5 引脚 SWD 编程头。

8. 外部电源 VIN 连接器 (J9): 此连接器将外部直流电源输入连接到板载稳压器和 USB Type-C 供电

系统。外部电源输入的电压应介于 5 V 和 12 V 之间。此外，当用作 USB Type-C 供电系统的输入

时，外部电源应具有足够的电流容量，以支持通过 Type-C 端口连接的负载。有关详细信息，请

参阅 EZPD CCG3 Type-C 供电 on page 38。
9. PSoC 6 MCU 用户按钮 (SW2): 该按钮可用于为 PSoC 6 MCU 提供输入。请注意，默认情况下，

该按钮在按下时将 PSoC 6 MCU 引脚连接到地，因此您需要将 PSoC 6 MCU 引脚配置为带有电

阻上拉的数字输入，以检测按键按下。此按钮还提供来自器件的低功耗模式的唤醒源。此外，该
按钮可用于激活 PSoC 6 MCU 的稳压器控制输出。

10.KitProg2 应用程序选择按钮 (SW4): 此按钮可用于在 KitProg2 编程模式和自定义应用程序模式之

间切换。有关更多详细信息，请参阅 KitProg2 用户指南。

11.Digilent®Pmod™ 兼容 I/O 接头 (J14): 此接头可用于连接 Digilent®Pmod™1 x 6 针模块。

12. 电源 LED (LED4): 这是琥珀色 LED，指示提供给 PSoC 6 MCU 的电源状态。

13. KitProg2 状态 LED (LED1， LED2 和 LED3): 红色，琥珀色和绿色 LED ( 分别为 LED1， LED2
和 LED3) 指示 KitProg2 的状态。有关 KitProg2 状态的详细信息，请参阅 KitProg2 用户指南。

14. PSoC 6 MCU 复位按钮 (SW1): 该按钮用于复位 PSoC 6 MCU。此按钮将 PSoC 6 MCU 复位 
(XRES) 引脚连接到地。

15. PSoC 6 MCU I/O 接头 (J18， J19 和 J20): 这些接头提供与未连接到 Arduino 兼容接头的 PSoC 
6 MCU GPIO 的连接。这些引脚中的大多数与板上外设复用，默认情况下不连接到 PSoC 6 
MCU。有关如何重新设计套件以访问这些引脚的详细信息，请参见 Table 1-2 on page 12。

16. Arduino 兼容电源接头 (J1): Arduino 兼容电源接头支持 Arduino 扩展板。此标头还具有通过 VIN
输入为套件供电的功能。
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套件操作
17. PSoC 6 MCU 调试和跟踪接头 (J12): 此接头可以连接到嵌入式跟踪宏单元 (ETM) 兼容的编程器

/ 调试器

18. Arduino Uno R3 兼容的 I/O 接头 (J2， J3 和 J4): Arduino 兼容的 I/O 接头引出 PSoC 6 MCU 的

引脚，与 Arduino 扩展板对接。这些引脚很少与板载外设复用，默认情况下不与 PSoC 6 MCU 连

接。有关如何重新设置套件以访问这些引脚的详细信息，请参见 Table 1-2 on page 12
19. PSoC 6 MCU 编程和调试接头 (J11): 该 10 引脚接头允许您使用外部编程器 ( 如 MiniProg3) 对

PSoC 6 MCU 进行编程和调试。此外，可以将外部 PSoC 4/5/6 器件连接到该接头，并使用

KitProg2 进行编程。要对外部设备进行编程，应使用 SW6 选择 “External” 选项。

20. KitProg2 编程目标选择开关 (SW6，位于电路板底部 ): 该开关选择编程目标，这是板载 PSoC 6 
MCU 与连接到 J11 的外部 PSoC 4/5/6 器件之间的板载 KitProg2 的目标。

21. CapSense 滑块 (SLIDER) 和按钮 (BTN0 和 BTN1): CapSense 触摸感应滑块和两个按钮，都具

有自电容 (CSD) 和互电容 (CSX) 操作功能，可以让您评估赛普拉斯的第四代 CapSense 技术。

滑块和按钮采用 1 毫米丙烯酸覆盖层，可实现平滑的触摸感应。

22. CapSense 接近接头 (J13): 可以将一根导线连接到此接头，以评估 CapSense 的接近感应功能。

23. 系统电源 VDD 选择开关 (SW5): 该开关用于选择 PSoC 6 MCU 的 VDD 电源电压，常量 1.8 V，常

量 3.3 V，变量 1.8 至 3.3 V。在 1.8 至 3.3 V 变量模式下， PSoC 编程器软件可以通过 KitProg2
控制电压。

24. PSoC 6 MCU 电流测量跳线 (J8，位于电路板底部 ): 可以将电流表连接到此跳线，以测量 PSoC 
6 MCU 消耗的电流。

25. Arduino 兼容 ICSP 接头 (J5): 该接头为 Arduino ICSP 兼容扩展板提供 SPI 接口。

26. PSoC 6 MCU 用户 LED (LED8 和 LED9): 这两个用户 LED 可以在 PSoC 6 MCU 的整个工作电

压范围内工作。 LED 处于低电平有效状态，因此必须将引脚接地以打开 LED。

27. RGB LED (LED5): 此板载 RGB LED 可由 PSoC 6 MCU 控制。LED 处于低电平有效状态，因此

必须将引脚接地以打开 LED。

28.赛普拉斯 512-Mbit 串行 NOR 闪存 (S25FL512SAGMFI011， U4): 该套件具有 512 Mb 容量的赛

普拉斯 NOR 闪存 ((S25FL512SAGMFI011) 。 NOR Flash 连接到 PSoC 6 MCU 的串行存储器接

口 (SMIF) 。 NOR 器件可用于数据和代码存储器，支持就地执行 (XIP) 和加密。

29. 赛普拉斯 4 Mbit 串行 F-RAM (FM25V10， U5): 封装以连接 FM25V10 或任何其他兼容 FRAM 的

引脚。

30. Vbackup 和 PMIC 控制选择开关 (SW7，位于电路板的底部 ): 这可以在 VDDD 和超级电容之间切

换到 PSoC 6 MCU 的 Vbackup 电源连接。选择 VDDD 时，稳压器 ON/OFF 由 KitProg2 控制。选

择超级电容时，稳压器 ON/OFF 由 PSoC 6 MCU 控制。

31. 赛普拉斯 PSoC 6 MCU (CY8C6347BZI-BLD53， U1): 该套件旨在突出 PSoC 6 MCU 的功能。

有关 PSoC 6 MCU 引脚映射的详细信息，请参见 Table 1-2 on page 12。
32. BLE 天线 : 这是 BLE 的板载摆动天线。

33. U.FL 连接器 (J17): 此连接器可用于导电测量，也可用于连接外部天线。

34. 赛普拉斯主电压调节器 (MB39C022GPN-G-ERE1, U6): 这是为 PSoC 6 MCU 供电的主调节器。

该调节器有两个输出通道。一个通道从 5 V 输入提供固定的基于 LDO 的 3.3 V 输出，另一个通道

是降压 DC-DC 转换器，配置为提供 1.8 V 至 3.3 V 的可变电压。

35. KitProg2 (PSoC 5LP) 编程器和调试器 (CY8C5868LTI-LP039， U2): PSoC 5LP 器件 
(CY8C5868LTI-LP039) 用作 KitProg2，是一个多功能系统，包括编程器、调试器、 USB-I2C 桥

接器、 USB-UART 和 USB-SPI 桥接器。 KitProg2 还支持自定义应用程序。有关更多详细信息，

请参阅 KitProg2 用户指南。
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套件操作
36. 电池连接器 (J15，位于电路板底部 ): 此连接器可用于连接锂离子聚合物电池。请注意，套件包

中不包含电池，如果要演示电池充电，应单独购买。

37. USB PD 输出 (J16): 当 USB Type-C 供电系统从连接到 J10 的外部主机接收电源时，此接头提供

电压输出。有关详细信息，请参阅 EZPD CCG3 Type-C 供电 on page 38。

有关各种硬件模块的详细信息，请参见硬件功能描述 chapter on page 43。

对于 PSoC 6 MCU 系列中的某些器件，以不受限制的驱动强度和频率对 GPIO 进行同步切换，可能会

在片上子系统中产生噪声，从而影响 CapSense 和 ADC 结果。有关更多详细信息，请参见相应器件

数据手册的勘误表部分。
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套件操作
3.1.1 CY8CKIT-028-EPD E-INK 显示扩展板

Figure 3-5.  E-INK 显示扩展板

E-INK 显示扩展板具有以下外设 : 
1. 2.7 英寸 E-INK 显示屏 : 这是一款单色 E-INK 显示屏，分辨率为 264x176。即使在没有电源的情

况下， E-INK 显示器也可以保留其内容，从而提供低功耗， “ 始终开启 ” 的显示功能。

2. 运动传感器 (U5): 这是一个 3 轴加速度和 3 轴陀螺仪运动传感器，可用于计算步数来模拟计步器

或类似应用。

3. 热敏电阻 (RT1): 该热敏电阻可用于显示器的温度补偿或作为通用环境温度传感器。

4. PDM 麦克风 (U1): 此麦克风将语音输入转换为脉冲密度调制 (PDM) 数字信号。

5. Arduino 兼容的 I/O 接头 (J2， J3 和 J4): 该接头通过电路板上的接头 J2 与 PSoC 6 MCU GPIO
连接。

6. Arduino 兼容电源和 I/O 接头 (J1): 此接头从电路板上的接头 J1 接收电源。

7. E-INK 显示屏电源控制负载开关 (U3): 该负载开关可由电路板控制，以切换 E-INK 显示器的电

源。

8. E-INK 显示屏连接器 (J5): 此连接器用于将 E-INK 显示器连接到 E-INK 显示屏蔽罩上的电路。

9. E-INK 显示 I/O 电压转换器 (U2): 该 I/O 电平转换器通过为 E-INK 显示屏提供恒定的 3.3 V 接口，

允许电路板在 1.8 和 3.3 V 之间的任何电压下工作。
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套件操作
3.2 KitProg2
PSoC 6 BLE Pioneer 套件可使用板载 KitProg2 进行编程和调试。KitProg2 是一个多功能系统，包括

编程器，调试器，USB-I2C 桥接器，USB-UART 桥接器和 USB-SPI 桥接器。KitProg2 还支持海量存

储编程和 CMSIS-DAP 以及自定义应用程序。赛普拉斯 PSoC 5LP 器件用于实现 KitProg2 功能。

KitProg2 集成在大多数 PSoC 开发套件中。有关 KitProg2 功能的更多详细信息，请参阅 “KitProg2 用

户指南 ”。

在对器件进行编程之前，请确保计算机上已安装 PSoC Creator 和 PSoC Programmer 软件。有关更

多信息，请参阅安装软件 chapter on page 25。

3.2.1 使用 PSoC Creator 进行编程和调试

1. 使用 USB 电缆将 PSoC 6 BLE Pioneer 套件连接到 PC，如 Figure 3-6 所示。如果您是第一次将

其连接到 PC，该套件将枚举为复合设备。成功的枚举由以下状态 LED 指示 : 琥珀色 LED 开，绿

色 LED 关，红色 LED 关。如果看不到所需的 LED 状态，请参阅 KitProg2 用户指南以获取有关

KitProg2 状态和故障排除说明的详细信息。例如，如果琥珀色 LED 显示呼吸效果，请按模式按钮

从大容量存储编程模式切换到 SWD 编程模式。

Figure 3-6.  连接 USB 线缆到套件上的接头

2. 在 PSoC Creator 中打开所需的项目。为此，请选择 File > Open > Project/Workspace。这提供

了浏览和打开已保存项目的选项。

3. 选择 Build> Build Project 选项或按 [Shift] [F6] 构建项目。

4. 如果构建期间没有错误，请选择 Debug> Program 或按 [Ctrl] [F5]。它可以在 PSoC 6 BLE 
Pioneer 套件上对器件进行编程。

PSoC Creator 具有集成调试器。您可以通过选择 Debug> Debug 或按 [F5] 来启动调试器。有关如何

使用 PSoC Creator 进行调试的详细说明，请参阅 KitProg2 用户指南中的 Debugging Using PSoC
Creator 部分
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套件操作
3.2.2 使用 PSoC Programmer 编程

PSoC Programmer 可用于将现有 .hex 文件编程到 PSoC 6 BLE Pioneer 套件中。有关如何使用 PSoC
Programmer 进行编程的详细说明，请参阅 “KitProg2 用户指南 ” 中的 “Programming Using PSoC
Programmer” 部分。

KitProg2 固件通常不需要任何更新。如有必要，您可以使用 PSoC Programmer 软件更新 KitProg2 固

件。有关如何更新 KitProg2 固件的详细说明，请参阅 KitProg2 用户指南中的 Updating the KitProg2
Firmware 部分。

3.2.3 大容量存储编程器

PSoC 6 BLE Pioneer 套件中的 KitProg2 支持通过 USB Mass Storage 接口进行编程。该接口允许您

通过将 .hex 文件复制到模拟 USB 大容量存储设备来对 PSoC 6 MCU 进行编程。用户可以按模式按钮

切换到大容量存储模式。那时，琥珀色 LED 将显示呼吸效果。再次按下模式按钮可切换到正常编程模

式。有关 KitProg2 海量存储编程器的更多详细信息，请参阅 KitProg2 用户指南。

3.2.4 USB-UART 桥接

PSoC 6 BLE Pioneer 套件上的 KitProg2 可用作 USB-UART 桥接器。PSoC 6 MCU 与 KitProg2 之间

的 UART 和流量控制线在板上硬连线，如 Figure 3-7 所示。有关 KitProg2 USB-UART 功能的更多详

细信息，请参阅 KitProg2 用户指南。

Figure 3-7.  KitProg2 和 PSoC 6 之间的 UART 连接
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套件操作
3.2.5 USB-I2C 桥接

KitProg2 可用作 USB-I2C 桥接器，并与桥接控制面板 (BCP) 软件通信。PSoC 6 MCU 上的 I2C 线路

在板上硬连线到 KitProg2 的 I2C 线路，带有板载上拉电阻，如 Figure 3-8 所示。 USB-I2C 支持 50
kHz、100 kHz、400 kHz 和 1 MHz 的 I2C 速度。有关 KitProg2 USB-I2C 功能的更多详细信息，请参

阅 KitProg2 用户指南。

Figure 3-8.  KitProg2 和 PSoC 6 之间的 I2C 连接

3.2.6 USB-SPI 桥接

KitProg2 可用作 USB-SPI 桥接器。PSoC 6 MCU 和 KitProg2 之间的 SPI 线路在电路板上硬连线，如

Figure 3-9 所示。有关 KitProg2 USB-SPI 功能的更多详细信息，请参阅 KitProg2 用户指南。

Figure 3-9.  KitProg2 和 PSoC 6 之间的 SPI 连接
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套件操作
3.3 EZPD CCG3 Type-C 供电

Pioneer 板包括赛普拉斯 EZ-PD CCG3 供电系统。该 EZ-PD™CCG3 经过预编程，可以从 Type-C 端

口向板载接头 J16 ( 称为消费者路径 ) 供电，同时为连接到 J15 的 3.7 V 锂离子聚合物电池充电。此

外，供电系统可以利用从 VIN (J9) 电源 ( 称为提供者路径 ) 获得的电力向诸如蜂窝电话的 Type-C 外

设供电。请注意，要使用 EZ-PD™CCG3 Type-C 供电系统，应将具有 USB Type-C 到 Type-C 电缆的

供电电缆连接到 J10。该电缆不包含在套件中，应单独购买。

Figure 3-10.  Type-C 框图

供电系统的工作原理如下 : 
1. 如果供电系统检测到非 Type-C 电源适配器 ( 传统 USB) ， CCG3 将以 100 mA 为电池充电。

CCG3 还将禁用使用者和提供者路径。

2. 在检测到 Type-C 电源适配器时， CCG3 将要求 3 A 时为 5 V、 9 V，或 12 V，具体取决于主机功

能。成功协商功率级别后，通过打开负载开关 U12 启用消费者路径。该负载开关的硬件限制为通

过插头 J16 向外部设备提供高达 1A 的电流。 CCG3 将使用剩余电流为连接到 J15 的电池充电，

充电速率高达 1.5 A， PD 输出电压可用性指示灯 (LED6) 将亮。
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3. 如果能够提供这些电压中的任何一个的直流电源连接在 VIN (J9) ， CCG3 还会宣称它可以提供 5 
V， 9 V 或 12 V。在这种情况下，电流限制为 1A。请注意，外部电源必须能够提供此电流。如果

连接的 Type-C 设备请求电源，则通过打开负载开关 U22 启用提供程序路径。下表详细介绍了板

载 CCG3 的供电场景。

* 由于串联组件的电压下降，使用 12 V PD 电源适配器时，J16 的电压为 ~9 V。填充 R79 电阻以绕过

此下降。

** 该表仅在首先连接Type-C电缆然后应用VIN时有效。如果首先应用VIN，那么消费者容量将为N/A。

有关使用 CCG3 器件的 USB Type-C 供电的更多信息，请参阅 Z-PD CCG3 网页。

Table 3-1.  Type-C 供电场景

USB 主机 / 用户容量 VIN 用户容量 提供者容量
外部 USB PD 输出 

(J16 接头 ) 电池充电电流

非 Type-C 电源适配器 ( 传
统 USB)

<5V N/A  0 0 100mA

>5V N/A  0 0 0

Type-C, PD 电源适配器 (
能够 12V)

<12V 12V@3A  0 12V@1A * 1.5A max

>12V N/A  0 0 0

Type-C, 能够提供最大 9V 
** <9V 9V@3A  0 9V@1A 1.5A max

>9V N/A  0 0 0

仅 Type-C，能提供最大
5V ** <5 5V@3A  0 5V@1A 1.5A max

>5 N/A  0 0 0

Type-C, 请求 12V ** ≠ 12V  0 5V@1A 0 0

12V  0 12V@1A 0 0

Type-C, 请求 9V ** ≠ 9V  0 5V@1A 0 0

9V  0 9V@1A 0 0

Type-C, 请求 5V ** ≠ 5V  0 5V@1A 0 0

5V  0 5V@1A 0 0

Type-C, 请求另外电压 ** 5V < VIN 
<12V  0 5V@1A 0 0
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4. 代码示例
PSoC 6 BLE Pioneer 套件包括三个代码示例。要访问代码示例，请从 www.cypress.com/CY8CKIT-
062-BLE 下载并安装 PSoC 6 BLE Pioneer Kit 安装文件。安装后，代码示例将可从 PSoC Creator 起
始页上的 Start> Kits 中获取。

4.1 使用套件代码示例

请按照以下步骤打开并使用代码示例。

1. 从 Start > All Programs > Cypress > PSoC Creator <version> > PSoC Creator <version> 启

动 PSoC Creator。
2. 在起始页面上，单击 Start> Kits 下的 CY8CKIT-062-BLE。将出现一个代码示例列表，如

Figure 4-1 所示。

3. 单击所需的代码示例，选择要保存项目的位置，然后单击 OK。

Figure 4-1.  从 PSoC Creator 打开代码示例

4. 通过选择 Build> Build <Project Name> 来构建代码示例。构建过程成功后，将生成 .hex 文件。

5. 使用 USB 电缆将 PSoC 6 BLE Pioneer 套件连接到 PC，如 Figure 3-6 所示，使用代码示例对套

件进行编程。

6. 在 PSoC Creator 中选择 Debug> Program。
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7. 如果已经采集了器件，编程将自动完成 - 结果将显示在屏幕左下方的 PSoC Creator 状态栏中。如

果尚未获取设备，将显示 Select Debug Target 窗口。选择 KitProg2 / <serial_number>，单击

Port Acquire，如 Figure 4-2 所示。

Figure 4-2.  端口获取

8. 获取设备后，它将显示在 KitProg2 / <serial_number> 下面的树形结构中。单击 Connect，然

后单击 OK 退出窗口并开始编程，如 Figure 4-3 所示。

注 : PSoC 6 MCU 同时具有 Arm Cortex M0+ 和 Arm Cortex M4 CPU。要进行编程，您可以选择

其中任何一个，然后单击 Connect。要进行调试，必须选择要调试的 CPU。

Figure 4-3.  从 PSoC Creator 连接设备并进行编程

9. 编程成功后，代码示例即可使用。
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4.2 代码示例

Table 4-1 显示了可与此套件一起使用的代码示例列表。有关特定示例的其他详细信息，请参阅单个代

码示例文档。

Table 4-1.  PSoC Creator 中代码示例

# 项目 说明

1 CE218136_EINK_CapSense_RTOS 此代码示例演示如何使用 E-INK 显示和 CapSense 创建用

户界面解决方案。

2 CE218137_BLE_Proximity_RTOS
此代码示例演示了带 BLE 的 PSoC 6 MCU 和 CySmart BLE
主机仿真工具或运行 CySmart 移动应用程序的移动设备之

间的连接，以传输 CapSense 接近感应信息。

3 CE219517_KitProg2_Power_Monitoring
此代码示例演示了如何创建可引导加载的 PSoC 5LP 
(KitProg2) 项目，以监控 CY8CKIT-062-BLE PSoC 6 BLE 
Pioneer 套件上 PSoC 6 MCU 器件所消耗的功耗。

4 CE220331_BLE_UI_RTOS

此代码示例演示了 PSoC 6 MCU 与用户接口功能的连接，

例如 E-INK 显示器， RGB LED 和基于自电容和互电容的触

摸传感器 (CapSense CSD 和 CSX) ，以及 PSoC 6 MCU
器件之间的双向 BLE 连接以及与运行 CySmart BLE 主机仿

真工具的 PC 或运行 CySmart 移动应用程序的移动设备之

间的连接。

5 CE222604_RTC_CTS_RTOS
此代码示例演示了 PSoC 6 MCU 的实时时钟 (RTC) 的准确

时间，该时钟与使用 BLE 当前时间服务 (CTS) 的当前时间

服务器 ( 如 iPhone) 同步。

6 CE220272_BLE_Direct_Test_Mode 此代码示例演示了使用具有 BLE 连接功能的 PSoC 6 MCU
在主机控制器接口 (HCI) 上的直接测试模式 (DTM) 。

7 CE218139_BLE_Eddystone_RTOS
此代码示例演示了一个 BLE 信标，用于广播 Google 的

Eddystone 信标配置文件的核心帧类型 (UID， URL 和

TLM) 。

8 CE218138_BLE_Thermometer_RTOS
此代码示例演示了 PSoC 6 MCU 与热敏电阻电路的接口，

以读取温度信息并通过蓝牙低功耗健康温度计服务 (HTS) 
将数据发送到运行 CySmart 移动应用程序的移动设备。

9 CE222793_MotionSensor_RTOS
此代码示例演示了如何将 PSoC 6 MCU 与 BMI160 运动传

感器连接。此示例读取传感器计数的步骤以模拟计步器。还
读取原始运动数据并用于预估板的定位。

10 CE222046_BLE_Throughput_
Measurement

此代码示例演示了如何在具有蓝牙低功耗 (BLE) 连接设备的

PSoC 6 MCU 上最大化 BLE 吞吐量。
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A. 附录
A.1 原理图

请参阅以下路径下的套件安装目录中提供的原理图文件 : 
1. <Install_Directory>\CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit\

1.0\Hardware\CY8CKIT-028-EPD\CY8CKIT-028-EPD Schematic.pdf

2. <Install_Directory>\CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit\
1.0\Hardware\CY8CKIT-062-BLE\CY8CKIT-062-BLE Schematic.pdf

A.2 硬件功能描述

本节详细介绍 PSoC 6 BLE Pioneer 板的各个硬件模块。

A.2.1 PSoC 6 MCU (U1)
PSoC 6 MCU 是赛普拉斯最新的超低功耗 PSoC，专为可穿戴设备和物联网产品而设计。它是一个真

正的可编程嵌入式片上系统，集成了 Arm® Cortex®-M4 作为主要应用处理器，100-MHz Arm Cortex-
M0+，支持低功耗操作，高达 1 MB 闪存和 288 KB SRAM，BLE 4.2 射频，CapSense 触摸感应，和

定制的模拟和数字外设功能。可编程模拟和数字外设功能可实现更高的灵活性，设计的现场调整以及
更快的上市时间。

有关更多信息，请参见 PSoC 6 MCU 网页和数据手册。

A.2.2 PSoC 5LP (U2)
板载 PSoC 5LP (CY8C5868LTI-LP039)) 用作 KitProg2，用于编程和调试 PSoC 6 MCU。PSoC 5LP
通过 USB 连接器连接到 PC 的 USB 端口，并连接到 PSoC 6 MCU 的 SWD 和其他通信接口。 PSoC
5LP是一种系统级解决方案，可在单个芯片中提供MCU、存储器、模拟和数字外设功能。CY8C58LPxx
系列提供现代的信号采集、信号处理和控制方法，具有高精度、高带宽和高灵活性。模拟能力涵盖从
热电偶 ( 近直流电压 ) 到超声波信号的范围。

有关更多信息，请访问 PSoC 5LP 网页。另请参见 CY8C58LPxx Family Datasheet。
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A.2.3 PSoC 5LP 和 PSoC 6 MCU 之间的串行互连

除了用作板载编程器之外， PSoC 5LP 还可用作 USB-UART， USB-I2C 和 USB-SPI 桥接器的接口，

如 Figure A-1 所示。PSoC 5LP 的 USB 串行引脚硬连线到 PSoC 6 MCU 的 I2C/UART/SPI 引脚。这

些引脚也可用于兼容 Arduino 的 I/O 接头 ; 因此， PSoC 5LP 可用于控制带 I2C/UART/SPI 接口的

Arduino 扩展板。

Figure A-1.  编程和串行接口连接的原理图
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A.2.4 EZ-PD CCG3 供电系统

赛普拉斯 EZ-PD CCG3 提供完整的解决方案，非常适用于电源适配器，移动电源， Type-C 加密狗，

显示器，底座和笔记本电脑。有关 Pioneer 电路板上供电系统实施的更多详细信息，请参见 EZPD
CCG3 Type-C 供电 on page 38。
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Figure A-2.  EZ-PD CCG3 供电系统原理图
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A.2.5 电源系统

该电路板上的电源系统功能多样，允许输入电源来自以下来源 : 

■ 板载 USB Type-C 连接器提供 5 V、 9 V 或 12 V 电压

■ Arduino 扩展板提供 5 V 至 12 V 电源，或通过 VIN 插头 J9 或 J1 从外部电源供电

■ 来自连接到 J15 的可充电锂电池的 3.7 V 电压

■ 来自连接到 J11 和 J12 的外部编程器 / 调试器的 5 V 电压

电源系统旨在支持 PSoC 6 MCU 的 1.8 V 至 3.3 V 操作。此外，供电电路和 KitProg2 的操作需要 5V
的中间电压。因此，三个稳压器用于实现 1.8 V 至 3.3 V 和 5 V 输出 - 降压升压调节器 (U21) ，从 5 V
至 12 V 输入产生固定的 5 V 电压，以及一个主稳压器 (U6) 产生可变 1.8 V 至 3.3 V，或 U21 输出的

固定 3.3 V。 Figure A-3 显示了电压调节器和功率选择电路的原理图。除此之外，电池充电器 U14 还

可用作升压调节器。U14 提升电池电压，为主调节器 U6 提供 5 V 电压。仅当 VIN 和 USB 电源不可用

时才启用此功能。

通过开关 SW5 进行电压选择。此外，板载 330-mF 超级电容 (C52) 可用于为 PSoC 6 MCU 的备份域

(VBACKUP) 供电。开关 SW7 选择 VDDD 和超级电容之间的 PSoC 6 MCU 的 VBACKUP 电源连接。

选择 VDDD 时，可变调节器 ON/OFF 端子由 KitProg2 控制。选择超级电容时，稳压器 ON/OFF 端子

由 PSoC 6 MCU 控制。为确保 PSoC 6 MCU 正常工作，选择超级电容时必须由 PSoC 6 MCU 在内部

充电，然后再关闭稳压器。有关 PSoC 6 MCU 备份系统和电源的更多详细信息，请参见 《PSoC 6
BLE 技术参考手册》。

Table A-1 详细介绍了 Pioneer 板的不同供电方案

Table A-1.  电源方案

电源输入 电路板状况

USB VIN ETM 接头 
(VTARG_IN) 连接电池

JTAG/SWD 接

头 
(VTARG_REF)

主稳压器电源
PSoC 电

源
电池充电

非 Type-C
电源适配器 
(传统USB), 

5 V

<5 N/A Yes N/A Type-C 主稳压器 100mA

>5 N/A N/A N/A VIN 主稳压器 No

Type-C, PD 
power 

adapter

<PD 电源适

配器
N/A Yes N/A Type-C 主稳压器 1.5A

<PD 电源适

配器

, <12V
N/A N/A N/A VIN 主稳压器 No

0V 5V–12V N/A N/A N/A VIN 主稳压器 No

0V 0V 5V N/A N/A ETM 
(VTARG_IN) 主稳压器 No

0V 0V 0V 3.2V–4.2V N/A Battery 主稳压器 No

0V 0V 0V 0V 1.8V–3.3V N/A

JTAG/
SWD 

(VTARG_
REF)

No
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Figure A-3.  电源系统原理图
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A.2.6 扩展连接器

A.2.6.1 Arduino 兼容接头 (J1， J2， J3， J4 和 J5) 

该板有五个与 Arduino 兼容的接头 : J1，J2，J3，J4 和 J5 ( 默认情况下不填充 J5) 。您可以连接 3.3-
V Arduino 兼容扩展板，以开发基于扩展硬件的应用。请注意，不支持 5 V 扩展，连接 5 V 扩展可能

会永久损坏电路板。有关 PSoC 6 MCU 引脚映射到这些接头的详细信息，请参见 Appendix A.3。

A.2.6.2 PSoC 6 MCU I/O 接头 (J18, J19, 和 J20)

这些接头提供与未连接到 Arduino 兼容接头的 PSoC 6 MCU GPIO 的连接。这些引脚中的大多数都与

板载外设复用，默认情况下不与 PSoC 6 MCU 连接。有关如何重新设置套件以访问这些引脚的详细信

息，请参阅 PSoC 6 BLE Pioneer 板修改 on page 53。

A.2.6.3 PSoC 5LP GPIO 接头 (J6)

J6 是电路板上提供的 8x2 接头，用于引出 PSoC 5LP 的多个引脚，以支持低速示波器和低速

数字逻辑分析仪等高级功能。此接头还包含 USB-UART， USB-I2C 和 USB-SPI 桥接引脚，

当 Arduino 接头上无法访问这些引脚时，可以使用该引脚，因为已连接屏蔽。附加的 PSoC
5LP 引脚直接连接到 PSoC 5LP 的内部可编程模拟逻辑。此接头还具有 GPIO, 用于自定义应

用程序使用。默认情况下不会填充 J6。请注意，这些接头上的 SPI， RTS 和 CTS 线路直接

来自 PSoC 5LP ( 电平转换器之前 ) 。

A.2.6.4 KitProg2 自定义应用程序接头 (J7)

电路板上提供了一个 5x2 接头，可以引出更多 PSoC 5LP GPIO，以便自定义应用程序使用。该接头

还引出 PSoC 5LP 编程引脚，可使用 MiniProg3 和五引脚编程连接器进行编程。默认情况下不会填充

J7。
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A.2.7 CapSense 电路

CapSense 滑块和两个按钮均支持自电容 (CSD) 和互电容 (CSX) 感应， CSD 接近传感器 ( 接头 ) 连
接到 PSoC 6 MCU，如 Figure A-4 所示。Pioneer 板上有四个外部电容 - 用于 CSD 的 CMOD 和 CSH，
用于 CSX 的 CINTA 和 CINTB。请注意，默认情况下不加载 CSH。有关使用 CapSense ( 包括设计
指南 ) 的详细信息，请参阅 Getting Started with CapSense Design Guide。

Figure A-4.  CapSense 电路原理图

具有不受限制的驱动强度和频率的同时 GPIO 切换可能会影响 CapSense 和 ADC 性能。有关更多详

细信息，请参见相应器件数据手册的勘误表部分。

A.2.8 LEDs
LED1， LED2 和 LED3 ( 分别为红色，琥珀色和绿色 ) 表示 KitProg2 状态 ( 有关详细信息，请参阅

KitProg2 用户指南 ) 。LED4 ( 琥珀色 ) 表示 PSoC 6 MCU 的供电状态。LED7 ( 绿色 ) 表示 J16 上的

电力传输输出状态。 LED6 ( 红色 ) 表示电池充电器状态。

Pioneer 板还具有两个用户可控 LED (LED8 和 LED9) 和一个 RGB LED (LED5) ，连接到 PSoC 6
MCU 引脚，用于用户应用。
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A.2.9 按压按钮

PSoC 6 BLE Pioneer 套件具有复位按钮和三个用户按钮。复位按钮 (SW1) 连接到 PSoC 6 MCU 的

XRES 引脚，用于复位器件。一个用户按钮 (SW2) 连接到 PSoC 6 MCU 的引脚 P0[4]。其余两个按钮

- SW3 和 SW4 分别连接到 PSoC 5LP 设备，用于编程模式和自定义应用程序选择 ( 有关详细信息，请

参阅 KitProg2 用户指南 ) 。默认情况下，所有按钮在激活时均为接地 ( 低电平有效 ) 。通过更改下面

显示的零电阻，可以将用户按钮 (SW2) 更改为高电平有效模式，以评估 PSoC 6 MCU 的 PMIC 控制

功能。有关重新设计、 Rev.08 或更早版本的更多信息，请参阅常见问题 on page 57 ( 第 29 项 ) 。

Figure A-5.  按压按钮原理图

A.2.10 赛普拉斯 NOR 闪存

Pioneer 主板具有 512 Mb 容量的赛普拉斯 NOR 闪存 ((S25FL512SAGMFI011) 。 NOR 闪存连接到

PSoC 6 MCU 的串行存储器接口 (SMIF) 。 NOR 闪存设备可用于数据和代码存储器，具有就地执行

(XIP) 支持和加密功能。

Figure A-6.  NOR 闪存原理图
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A.2.11 赛普拉斯 F-RAM
Pioneer 板包含 FM24V10-GTR F-RAM 器件 ( 见 Figure A-7) ，可通过 SPI 接口访问。F-RAM 为 1Mbit
(128KB×8) ， SPI 速率高达 40 MHz。

Figure A-7.  F-RAM 原理图

A.2.12 晶振

Pioneer 板包括用于 PSoC 6 BLE 器件的 32 MHz ECO 和 32 KHz WCO。

Figure A-8.  ECO 和 WCO 原理图
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A.3 PSoC 6 BLE Pioneer 板修改

A.3.1 旁路 PSoC 6 MCU 上的保护电路编程和调试头 (J11) 

10 引脚接头允许您使用外部编程器 ( 如 MiniProg3) 对 PSoC 6 MCU 进行编程和调试。该接

头具有保护电路，可切断 VTARG_REF 引脚上大于 3.4 V 的任何电压。这是为了确保 PSoC
6 MCU 和其他 3.3 V 器件不会因过压而损坏。

Figure A-9.  旁路保护电路原理图

如果外部编程器提供稍高的电压，例如 3.42 V，并且您仍然需要使用编程器，则可以通过填充旁路零

欧姆电阻 R152 来绕过此保护电路。

请注意，当使用外部电源时，此更改将危及保护电路，如果外部电压超过器件的绝对最大限制，则会
对任何 3.3 V 器件造成永久性损坏。例如， PSoC 6 MCU 器件为 3.6 V，请参见相应器件数据手册中

的绝对最大电压限值。
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A.3.2 PSoC 6 MCU 用户按键 (SW2)
默认情况下，此按钮在按下时将 PSoC 6 MCU 引脚连接到地，您需要将 PSoC 6 MCU 引脚配置为带

有电阻上拉的数字输入，以检测按键按下。如果要在 PSoC 6 MCU 引脚上检测到高电平有效，则应移

除电阻 R150 并填充 R149。这将连接按下时将 PSoC 6 MCU 引脚连接到 VDDD 的按钮。此外，还提

供了上拉和下拉电阻的封装，如果需要外部上拉，可以填充这些电阻。

Figure A-10.  PSoC 6 MCU 用户按钮 (SW2) 原理图

A.3.3 CapSense 屏蔽

CapSense 按钮和滑块周围的阴影图案接地。如果需要耐水，则需要将此图案连接到屏蔽引脚。该模

式可以分别连接到由 R138 或 R137 填充的两个端口 P6.3 或 P13.6 中的任何一个。在这两种情况下，

需要去除将阴影图案连接到地的电阻器 R144。这些引脚需要配置为 PSoC Creator 中的屏蔽引脚。

将阴影图案连接到屏蔽而不是接地也将减少传感器的寄生电容。

Figure A-11.  CapSense 屏蔽原理图
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A.3.4 CSH
屏蔽槽电容 (CSH) 默认不填充。该电容是可选的，当使用 CSD 感应时，可用于改进的屏蔽电极驱动

器。您可以删除 R88 以从端口断开端口 7.3 并为 CSH 填充 C88 (10 nF) 。请参阅物料清单 (BOM) 以
获取建议的部件号。

Figure A-12.  CMOD, CSH 和 CINT 原理图

A.3.5 U.FL
该连接器可用于导电测量，也可用于连接外部天线。默认情况下不加载。移除 L1，C1，填充 L2，C4
并填充 U.FL 连接器 (J17) ，将 ANT 引脚从 PSoC 6 MCU 连接到连接器。有关推荐的部件号，请参见

物料清单。

Figure A-13.  U.FL 连接器 (J17) 原理图
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A.3.6 锂电池充电器

默认情况下不加载用于锂离子聚合物电池充电器的电池连接器 (J15) ; 这需要填充以评估电池充电和

电池供电选项。请参阅 BOM 以获取推荐的部件号。推荐的锂离子聚合物速率在 850 mAH 或更高时为

3.7 V. SparkFun Electronics PRT-13854 或同等电池可以使用。

Figure A-14.  锂电池充电器原理图

A.3.7 复用 GPIO
某些 PSoC 6 MCU 引脚与板载外设复用，默认情况下不连接到连接器或其他辅助组件。有关访问这些

引脚所需的修改的详细信息，请参见 PSoC 6 引脚映射表。

R80 402ohm
1% VBAT

J15

HDR_S 2x1_R/A
No Load

1
2

LiPo Battery Charger 
TP14
RED
No Load

Battery Connector

C48
2.2uF
10V

C12
0.1uF

50V

CHG_L

TS

C19
10uF
10V

C9
4.7uF
25V

VCC_5V U14

BQ24266RGER

PMID
1

BOOT
2

DRV
3

CE
4

TS
5

SYS
6SYS
7

BAT
8

BAT
9

PG
10

BGATE
11

ISET
12

CHG
13

IUSB3
14

VDPM
15

IUSB2
16 IUSB1
17

IN
18

IN
19

AGND
20

PGND
21

PGND
22

SW
23SW
24

EPAD
EPAD

C8
1uF
25V

R69
26.7K

1%

VBAT
R70
10K

L6

1.5uH

C66
1uF
25V

VBAT_PP

C42
1uF
25V

IUSB1

C37
22uF
25V

IUSB3
IUSB2

CE_L

VDRV

   

  
CY8CKIT-062-BLE PSoC 6 BLE Pioneer 套件指南, 文档编号: 002-29069 Rev. *A 56



A.4 物料清单

请参阅安装的套件软件中以下路径中的 BOM 文件

1. <Install_Directory>\CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit\1.0\
Hardware\CY8CKIT-062-BLE\CY8CKIT-062-BLE PCBA BOM.xlsx

2. <Install_Directory>\CY8CKIT-062-BLE PSoC 6 BLE Pioneer Kit\1.0\
Hardware\CY8CKIT-028-EPD\CY8CKIT-028-EPD PCBA BOM.xlsx

A.5 常见问题

1. 我的电脑上没有 Type-C 连接器。我仍然可以连接并使用此套件吗？

是。要评估 PSoC 6 MCU 的功能，任何具有 USB 2.0 连接的 PC 都已足够。仅在评估套件的

CCG3 部分时需要 Type-C 电源适配器。

2. 当多个电源插入时， CY8CKIT-062-BLE 如何处理电压连接？

为基板供电有五种选择 : Type-C USB 连接器 (J10) ，通过 VIN 连接器的外部 DC 电源 (J9/J1) ，
调试和跟踪头 (J12， VTARG_IN) ，程序和调试头 (J11) 以及 LiPo 电池接头 (J15) 。 Type-C 和

VIN 优先于其他供应选项。这些输入使用二极管进行 “ 或 ” 运算，两者之间的较高电压优先。

ORing 二极管的输出提供给降压 - 升压稳压器 (U16) ，产生恒定的 5.2 V。此输出与 ETM 电源 
(J12) 进行 “ 或 ” 运算，通常为 5 V。对于大多数实际应用，输出为 5.2 V 稳压器优先，同样作为

赛普拉斯电压调节器 (U6) 的输入。当不存在所有上述源时，使用 LiPo 电池。降压调节器 (U6) 的
输出与来自程序和调试头 (J11) 的电源电压进行 “ 或 ” 运算，并且更高的电压优先。有关电压输入

和输出方案的更多详细信息，请参见电源场景表格。

3. 如何访问连接到板载外设的 Smart I/O 和其他 GPIO？

一些 Smart I/O ( 端口 8 和端口 9.3) 和连接到板载外设的 GPIO 与 PSoC 6 MCU I/O 接头 (J18，
J19 和 J20) 复用。默认情况下，这些 I/O 中的一些使用串联电阻连接到板载外设。可以更改这些

电阻以将这些 I/O 路由到接头。请参见 Table 1-2 on page 12。有关需要更改的电阻列表的详细信

息，请参见 Pioneer 板引脚布局。

4. 当开关 SW7 设置为 SuperCap 位置时，为什么 RGB LED (LED5) 的红色 LED 亮起？

如果 SuperCap 充电电压低于 1.5 V，则会出现此行为。参考此域的 I/O 将泄漏电流，在本例中为

P0[3]。在将 SW7 切换到 SuperCap 位置之前，需要在硅片中启用 VBACKUP 功能。有关启用

SuperCap 充电的选项，请参阅 TRM/ 数据表。

5. 我可以使用 U.FL 连接器以及这些连接器的典型插接周期是什么？

U.FL 可用于导电测量和连接外部天线。 U.FL 连接器不是为重新连接而设计的。它们的额定电流

仅为约 30 插接周期。

6. 基板上使用的三个选择开关是为了什么？

Table 1-1 on page 11 提供了有关所有 3 个选择开关的详细信息。此外，每个代码示例文档都解释

了每个代码示例所需的选择开关设置。

7. 板载跳线的使用目的？

跳线 J8 可用于测量 PSoC 6 MCU 的电流，而无需从电路板上拆除任何元件。可以在此跳线上连

接电流表，以测量 PSoC 6 MCU 消耗的电流。取下 J8 上的跳线，连接电流表 ( 电流表的正极端

子连接到引脚 2) ，然后通过 USB 连接器 J10 为套件供电。

注意 : 请移除电阻 R4，因为该电阻会在连接到 VTARG 的 VBACKUP 域上引起 4 µA 的泄漏。
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Figure A-15.  电路板上跳线 J8

8. 输入电压容差是多少？该套件是否有过压保护？

输入电压电平如下 : 

9. 为什么套件的电压限制在 3.3 V？它不可以驱动外部 5 V 接口吗？

PSoC 6 的工作电压不应当超过 3.6 V。将 PSoC 6 供电提高至 4 V 以上会永久性损坏芯片。您不

能使用超过 3.6 V 的电源电压驱动 I/O 系统。

10.在为 PSoC 6 MCU 上电时，我错误地为 Arduino 板上电。我的 PSoC 6 设备是否还能用？

是的，能用。 Arduino 电源接头上的 3.3 V 和 5 V 不是输入引脚，并具有保护电路以防止电压进入

电路板。 VIN 是一个输入引脚，它连接到稳压器，它的绝对最大值为 15 V。 P6.VDD 引脚没有保

护，应注意不要为该引脚提供电压。

11. 这个套件我可以使用什么类型的电池？

推荐的锂离子聚合物额定值为 3.7 V， 850 mAH 或更高。可以使用 SparkFun Electronics PRT-
13854 或同等级电池。根据 USB 连接是传统设备还是支持 PD，锂电池充电器可以在 100 mA 或

1.5 mA 充电。

12.我错误地把电池的极性连反了，我把系统烧坏了吗？

该套件具有相关的保护电路，可保护系统免受永久性损坏。长时间连接可能会导致损坏。

13.我可以用这个套件为任何 Type-C 设备充电吗？

该套件经过编程，可通过额定电流为 1 A 的 VIN 电压进行通告。建议使用 5 V 和 12 V 器件。 VIN
需要分别为 9 V 和 12 V 才能工作。

Table A-2.  输入电压电平

电源 典型输入电压 绝对最大值 ( 过压保护 )
USB Type-C 连接器 (J10) 4.5 V to 12 V 15 V
VIN 连接器 (J9/J1) 5 V to 12 V 15 V

调试和跟踪接头 (J12) 5 V 5.5 V

编程和调试接头 (J11) 1.8 V to 3.3 V 3.6 V
锂电池连接 (J15) 3.2 V to 4.2 V 5 V
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14. 如何开始评估 USB Type-C 提供商和消费者功能？

您可以根据您要评估的功能使用任何类型的 Type-C 笔记本电脑、移动电话或 PD 适配器。作为消

费者使用时，请注意笔记本电脑等设备可能只能提供 5 V 输出，如果没有扩展坞，则可能无法支

持 9 V/12 V。要用作提供商，可以使用任何电流要求低于 1 A 的 5 V/9 V/12 V 设备。此外，赛普

拉斯还拥有自己的 USB Type-C 评估套件，可用于评估提供商和消费者功能等等。有关这些套件

的详细信息，请访问 http://www.cypress.com/products/usb-type-c-and-power-delivery。
15. 为什么 EPD 的屏幕会永久打开？

电子纸和 e-paper 是模仿纸上普通墨水外观的显示装置。与发光的传统背光平板显示器不同，电

子纸显示器像纸一样反射光。与大多数发光显示器相比，这可以使其更舒适地阅读并提供更宽的
视角。截至 2008 年，电子显示屏的对比度接近报纸，新开发的显示器略胜一筹。理想的电子纸

显示可以在阳光直射下读取，而不会使图像褪色。许多电子纸技术在没有电的情况下无限期地保
存静态文本和图像。要了解详细信息，请访问 https://en.wikipedia.org/wiki/Electronic_paper。

16. 为什么 EPD 的屏幕在每次转换过程中都会从黑色到白色？

EPD 屏蔽的屏幕在每次过渡时都会刷新。它首先通过用白色像素展开来清除显示器的所

有单元，然后发布图像。

17. 当我触摸 CapSense 滑块 / 按钮附近的电阻时，会触发 E-INK 显示屏和 LED。为什么会这样？

这些是串联限制电阻，可将 CapSense 线与 IC I/O 线连接起来。当您接触 CapSense 线

时，它会触发 E-INK 显示屏，响应 CapSense。
18. 关闭套件后， EPD 屏蔽显示白线和黑线。 EPD 屏蔽是否损坏？

当您关闭套件时， EPD 会保留图像。如果在图像之间转换期间套件电源关闭，则可能会出现线

条。

19. 我无法编程目标设备。

a. 检查 SW6 以确保它处于 PSoC 6 MCU 位置。

b. 检查 SW7 以确保其处于 VDDD/KitProg2 位置。

c. 确保没有外部设备连接到 J11。
d. 使用 KitProg2 用户指南中提到的步骤将编程器中的 KitProg2 版本更新为 1.04 或更高版本。

e. 确保 PSoC Creator 中使用的器件为 CY8C6347BZI-BLD53
20. 当我从另一个赛普拉斯套件通过 J1 接头给套件供电时，套件是否通电？

是的， J1 接头上的 VIN 引脚是电源输入 / 输出引脚，最高可达 12 V。
21. CapSense 可以使用哪些额外的覆盖层？

此 CapSense 可以使用任何类型的覆盖层 ( 厚度达 5 毫米 ) ，如木材，丙烯酸和玻璃。请注意，

更改覆盖层时可能需要进行其他调整。

22. 什么是 PMOD？

PMOD 接口或外设模块接口是 Digilent 公司在 Digilent Pmod 接口规范中为 FPGA 和微控制器使

用的外设定义的开放标准。有几种类型的模块，从简单的按钮到更复杂的模块，包括网络接口，
模数转换器或 LCD 显示器。 PMOD 可从多家供应商处获得，例如 Diligent， Maxim Integrated，
Analog Devices 和各种业余爱好网站。该套件仅支持 1 x 6 针 PMOD 模块。
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23. 我可以使用这个底板和什么类型的赛普拉斯屏蔽板配合？

任何支持 3.3 V 操作的 Arduino Uno 屏蔽板均与此 Pioneer 板兼容。以下赛普拉斯屏蔽板引脚与

该 Pioneer 板引脚兼容 : 
a. CY3280-MBR3
b. CY8CKIT-022
c. CY8CKIT-024
d. CY8CKIT-026
e. CY8CKIT-040
f. CY8CKIT-046
g. CY8CKIT-048

24. 我可以将此套件用作编程器来编程外部 PSoC 器件吗？

可以，板载 KitProg2 可以对连接到 J11 接头的任何 PSoC 4/5/6 器件进行编程。开关 SW6 应切

换到 “External Device” 位置，以编程通过 J11 接头连接的设备。

25. 该套件支持哪些第三方调试器？

支持多个第三方 IDE; 比如 IAR 和 μVision。有关支持的设备和导出到这些 IDE 的过程的更多详细

信息，请参见 PSoC Creator 帮助菜单。

26. 我是否可以仅使用 1.8 V 的外部编程器通过 J11 接头为 PSoC 6 MCU 供电？

是的，但由于过压保护电路上存在电压下降，可能会出现故障。 R152 可以填充以旁路保护电路，

但由于 PSoC 6 MCU 损坏的风险增加，因此不推荐使用 R152。
27. 我是否可以仅使用 3.3 V 的 MiniProg3 为 PSoC 6 MCU 供电和编程？

MiniProg3 Rev *B 的目标电压误差超过了可能导致故障的过压保护电路的容差。但是，这将适用

于 MiniProg3 Rev *C，它具有更小的目标电压误差。 R152 可以填充以旁路保护电路，但由于

PSoC 6 MCU 损坏的风险增加，因此不推荐使用 R152。
28. 当我使用 SW5 选择 1.8 V 的电源电压时，为什么板载 RGB LED (LED5) 不工作？

板载 RGB LED 需要高于 2.7 V 的电源电压才能正常工作。确保 SW5 设置为 3.3 V 或 1.8 V-3.3 V 
VARIABLE， PSoC Programmer 在后一种情况下选择 2.7 V 或更高的电压。使用电压低于 2.7 V
的套件会影响 RGB LED 的工作。或者，如果应用允许，您可以使用分立 LED (LED8 和 LED9) 。

29. 如何使用 SW2 进行 PMIC 唤醒？

SW2 连接到 PSoC 6 MCU 的 PMIC_Wakeup_In 引脚 (P0.4) 。 PMIC_Wakeup_In 引脚上的逻辑

高电平输入可以唤醒系统并启用 PMIC。有关此功能的更多详细信息，请参见 PSoC 6 MCU 
Architecture Technical Reference Manual 中的 Backup 一章。

SW2 应从外部下拉接地，以使用 PMIC 控制。此外，当按下开关时，高电平有效逻辑应将 P0.4
推至 VBACKUP 电源。但是，该套件默认配置为使用低电平有效逻辑。此外，在 Rev08 和早期

版本的套件中， SW2 的高电平有效逻辑将 P0.4 推至 VDDD。因此，需要对套件进行以下修改才

能使用 PMIC 控制功能 : 
❐ 移除 R150 并将 R150 和 R149 之间的公共焊盘连接到超级电容器 (C52) 的正极。

❐ 加载外部下拉电阻 R148。
参见 Figure A-16 了解更多细节。
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Figure A-16.  使用 PMIC 控制所需的修改
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